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Resumo

No seguimento dum artigo anterior acerca da analise de regressao nao-linear (simples) utili-
zando a ferramenta Solver®) do Excel®) (Esteves| [2010) propse-se neste artigo a apresentagiao
do R, uma linguagem de programacio e um ambiente para computacio estatistica e grafica,
através da sua aplicacao na “descricao” de relacoes estatisticas (nao-lineares) entre variaveis.
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Introducao

O R (R Development Core Team, [2007) é ao mesmo tempo uma linguagem de programacao e
um ambiente para computagdo estatistica e grafica. Trata-se de uma linguagem de programacio
especializada em computacao com dados. Uma das suas principais caracteristicas é o seu carac-
ter gratuito e a sua disponibilidade para uma gama bastante variada de sistemas operativos (vd.
http://www.r-project.org). Apesar do seu caracter gratuito, o R é uma ferramenta bastante pode-
rosa com boas capacidades ao nivel da programagio e um conjunto bastante vasto (e em constante
crescimento) de packages que acrescentam bastantes potencialidades a ja poderosa versdao base do
R (Torgo, 2006)). Contudo, o termo “ambiente” pretende caracterizar o R como um sistema com-
pleto e coerente ao invés dum conjunto de ferramentas muito especificas e relativamente inflexiveis
(Venables et al., [2006).

O R pode ser entendido como uma implementacao da linguagem S desenvolvida por Rick Bec-
ker, John Chambers e Allan Wilks nos Bell Laboratories (E.U.A.), que também constitui a base
do software S-Plus@®) (Insightful Corp.). A evoluco da linguagem S est& descrita em quatro livros
de John Chambers e colaboradores. As “distribui¢des” do R incluem um bom conjunto de manuais
(vd. http://cran.r-project.org/manuals.html) e existem, actualmente, varios livros que descre-
vem a utilizacdo do R para anélise estatistica de dados (vd. http://www.r-project.org/doc/bib/R-
books.html), e.g. |Dalgaard| (2002) ou |Crawley| (2007). Na ultima revisdo deste artigo usei a
versao 2.12.0 (embora sejam disponibilizadas regularmente “novas” versdes do R). O ficheiro de
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instalagdo (R-X.XX.X-win32.exe) para Microsoft Windows®) pode ser obtido em http://cran.at.r-
project.org/bin/windows/base/| e o processo de instalacdo é simples. Também existem “versdes”
para Mac OS e Unix/Linux, e 64-bit para Windows. O sitio electrénico do projecto constitui a
principal referéncia do R e funciona como ponto de partida para explorar mais este sistema.

Boa parte das pessoas utiliza o R como um sistema para anélise estatistica de dados, uma vez
que a maioria das “estatisticas classicas” e muitas das metodologias mais recentes estao disponiveis,
embora 0os promotores prefiram “pensar” o R como um ambiente no qual essas técnicas tém sido
implementadas (Venables et al., [2006). Cerca de 25 pacotes (i.e. conjuntos de fungoes) fazem
parte do sistema bésico (os “recommended” packages), mas muitos outros estdo disponiveis através
do CRAN (via http://CRAN.R-project.org) para instalagio.

Uma importante diferenca entre a linguagem S (e o R) e outros sistemas (e.g. SPSS®) ou
SAS®)) reside na (muito) menor quantidade de resultados apresentados para uma qualquer analise
estatistica, embora os resultados sejam guardados em objectos para posterior consulta ou utilizacao
pelo R noutras fungoes (Venables et al., [2006]).

Neste artigo, pretende-se apresentar (muito sucintamente) o R, uma linguagem de programagcao
especializada em computacao com dados, utilizando-a para analisar problemas cujo objectivo é
“descrever” relagOes estatisticas (ndo-lineares) entre varidveis. Nao se pretende discutir aqui os
aspectos estatisticos dos resultados obtidos, apenas o modus operandi (ainda que de forma simpli-
ficada).

Regressao nao-linear (simples)

Os varios aspectos relacionados com a regressdo nao-linear (simples) que servem de base a este
artigo foram abordados, ainda que de forma informal e possivelmente incompleta, num artigo
anterior (Esteves| [2010)).

Em vérios dominios do conhecimento, e.g. biologia, fisica, quimica, engenharia, etc., sdo usados

modelos matematicos para descrever um conjunto de dados empiricos, genericamente

y=1[(@)+e

em que y é a variavel dependente, = é a variavel “independente” — por vezes, controlada pelo
investigador — e f(z) é uma fun¢io que pode incluir um ou mais parimetros 6 e € sdo os erros
aleatorios, independentes e com distribuicdo normal. Outra formulacdo, equivalente, é § = f(x)
(em que ¢ se lé valor esperado, ou estimado, de y). Quanto melhor f(z) se ajustar aos dados,
mais “rigorosamente” descreverd aquela relagdo (Brownl 2001). Pretende-se ajustar a funcio f(z)
aos dados empiricos de forma a minimizar os erros ¢; = (y; — §). De facto, o objectivo é estimar
o(s) parametro(s) da funcdo f(z) de modo a minimizar a soma dos quadrados dos erros, SQE —
método dos minimos quadrados. No caso de funcdes (ou modelos) nao-lineares, e.g. y = aexp(br),
nao é possivel obter as estimativas dos parametros num tnico passo, como no caso de regressoes
lineares, pelo que a SQE é minimizada através dum processo iterativo (ciclico) utilizando um
algoritmo apropriado que necessita dos valores iniciais dos parametros 6y (Bowen and Jerman)
1995). Tradicionalmente, transformam-se as variaveis de alguns modelos ndo-lineares de forma a
linearizar a relagao e a permitir a sua andlise através da regressao linear. Contudo, esta abordagem

é valida se a(s) variavel(is) transformadas se verificam os pressupostos da analise de regresao linear.
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Figura 1: Aspecto da janela R Console.

Exemplo

A utilizagdo do R com um exemplo concreto (entretanto abordado por usando a
ferramenta Solver®) do Microsoft Excel®)) permitird mostrar o funcionamento e demonstrar as
capacidades do software. Como se imagina, as funcionalidades nao se esgotam no que aqui se
apresenta.

O aspecto do R ao iniciar uma sessao de trabalho em ambiente Windows(@®) ilustra-se na Figura
Para além da barra de ferramentas no topo (que permite realizar as tarefas comuns: abrir/gravar
ficheiros, cortar/colar texto, instalar pacotes, “gerir” as janelas, etc.) surge uma janela (R Console)
na qual se introduzem os comandos, a seguir ao sinal >.

Admita-se que os dados que se pretendem analisar estdo num ficheiro do Excel®). Em primeiro
lugar, sera necessario guardar uma versdo (*.txt ou *. csvﬂ desse ficheiro utilizavel pelo R (devem
usar-se pontos, em vez de virgulas, como separadores decimais).

Na consola do R escrever (fazendo Enter no fim),

> dados<-read.table(file="G:/MyArticles/ArtigosRegressaoNaoLinearExcel/Regre

ssaoNaoLinear.txt" ,header=T,sep="\t")

para “carregar” a informacao contida no ficheiro RegressaoNaoLinear.txt para o objecto dados.
(atente-se na notacdo <-). Os parametros header e sep permitem considerar os roétulos dos dados
e o tipo de ficheiro de texto (neste caso separado por tabulagoes), respectivamente. Por sinal, a

quantidade de dados envolvida poderia muito bem ser introduzida directamente no R através de

> C02<-c(141,172,181,227,309,414,641, 936)
> Prop<-c(0.25,0.34,0.34,0.68,0.85,0.99,0.98,0.99)

em que c(...) permite concatenar um conjunto de dados num objecto (neste caso, CO2 e Prop) .

Podemos visualizar a informagao usando a funcao plot

LA extensdo txt diz respeito a ficheiros de texto separado por tabulacdes enquanto a extensio csv esta relacionada
com ficheiros de texto separados por virgulas.



> plot(Prop~C02, las=1,x1lim=c(0,1000),ylim=c(0,1),pch=16,cex=
1.5, x1ab="C02 (ppm)", ylab="Proporgio de respostas correctas")

em que Prop~C02 descreve o “modelo” que se pretende representar (neste caso Prop em fungao
de C02) e cujos restantes parametros especificam as varias caracteristicas do gréfico (las para
orientagao dos rétulos do eixo dos yy, x1im e ylim para determinar os limites dos eixos, pch para
definir o simbolo usado, cex para aumentar o tamanho relativo dos caracteres, e x1ab e ylab para
“legendar” os eixos) (Figura 2p). Para mais informacoes acerca desta (ou qualquer outra) funcio

pode fazer-se
> 7plot

(ou entdo procurar com >help.search(‘“termo’®) ou, ainda, usar a opgdo Help>
Apropos...). Usando o botao direito do rato sobre o grafico, é possivel copiar a figura (como
metaficheiro Windows@®) por exemplo) para inclusdo num ficheiro do Microsoft Word®).

Admita-se (por razoes cientificas) que um modelo “dose-resposta” (logistico modificado)

L 4 cap(B(T — log(x))

P= 1+ exp(T — log(x))

em que P; é a propor¢do de respostas positivas do provador i, log(z) é o logaritmo do valor do
estimulo z, B é o "declive" e T é o limiar para o provador i (em log(x)), é adequado para descrever
os dados. Para ajustar o modelo basta fazer

> ajuste<-nls(Prop~(1/3+exp(B*(T-1ogl0(C02))))/(1+exp(B*(T-1ogl10(C02)))),
data=data.frame(C02=C02,Prop=Prop),start=1ist (B=-10,T=2.5))

em que o objecto ajuste incluira os resultados duma regressao nao-linear (através da fungao nls)ﬂ
do modeldﬂ Prop~ (1/3+exp(B*(T-1ogl10(C02))) )/ (1+exp(B*(T-1ogl10(C02))) considerando os
dados (indicados para o parametro data sob a forma de uma data. framﬂ e as estimativas iniciais
dos parmetros do modelo descritas em start (através duma list). Os resultados do ajuste

(Figura[3) podem ser consultados fazendo
> summary (ajuste)

E possivel ilustrar o ajuste, obtendo primeiro as estimativas da variavel Prop (através da
funcdo predict) e “desenhando-as”, em seguida, sobre o grafico entretanto obtido (Figura [2p vs

Figura ) usando a funcdo lines, ou seja

> PropEsp<-predict(ajuste,newdata=1ist(C02=seq(0,1000,length=100)),se.fit=T)
> lines(PropEsp~seq(0,1000,length=100) ,1wd=2,col=6)

A informagdo contida no objecto ajuste permite obter as estimativas para 100 valores de C02
entre 0 e 1000 (dai o parametro seq(1,1000,length=100) no comando acima) assim como os
respectivos erros-padrao (se.fit=T) que serdao guardadas no objecto designado PropEsp. A adigao

duma linha espessa e magenta (1wd=2 e col=6) & Figura [2h ¢ relativamente facil (Figura [2b).

20utras fungdes (muito) usadas sdo lm e aov para regressio linear (i.e. modelos lineares) e analise de variancia,
respectivamente.

3A defini¢dao dos modelos em S esta minuciosamente descrita em |Chambers and Hastie| (1992).

4Neste caso, considerou-se que o utilizador introduziu directamente no sistema os dados ao invés de “carregar” o
ficheiro dos dados (sendo que bastaria apenas indicar data=dados, no comando).



Figura 2: Diagramas de dispersao da proporcao de respostas vs. concentracao de CO2: dados origi-
nais (a); modelo “dose-resposta” (logistico modificado) (b); modelo “dose-resposta” com intervalos
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Figura 3: Aspecto da execugdo de comandos e respectivos resultados

na janela R Console.



Podem, ainda, obter-se e “desenhar-se” os intervalos de confianca (upIC e 10IC) que se calculam
através de § £t - se(Y), recorrendo as fungdes qt (para obter os valores “tedricos” de t-Student
e cujos parametros sdo 1 — «/2, neste caso 0.975, e os graus de liberdade do erro, que se obtém
de summary(ajuste)$df[2]), summary(ajuste)$sigma para obter o erro-padrao das estimativas

e lines, respectivamente (Figura 2).

> upIC<-PropEsp+qt(.975,summary (ajuste)$df [2]) *summary (ajuste) $sigma
> 1oIC<-PropEsp-qt(.975,summary(ajuste)$df [2]) *summary (ajuste) $sigma
> lines(upIC~seq(0,1000,length=100) ,col=4)
> lines(1oIC"seq(0,1000,length=100) ,col=4)

O modo mais simples de “testar” a bondade do ajuste é representar graficamente os dados e o mo-
delo ajustado (bem como os respectivos intervalos de confianga), de modo a verificar (visualmente)
se os parametros obtidos numericamente descrevem, de facto, a relagdo entre variaveis (Figura )
Por outro lado, a analise gréfica dos residuos, e.g. residuos vs. valores observados de X, permite
“verificar” se o modelo é adequado (os residuos representam apenas o erro experimental se nao

apresentam tendéncias ou padroes). Sendo assim, obter os residuos através de
> residuos<-summary(ajuste)$resid

e, em seguida, representar esse grifico em conjunto com o normal probability plot dos residuos
(Figura [4))

> op<-par (mfrow=c(2,1) ,pty="s",las=1)

> plot(residuos”predict(ajuste) ,pch=16,co0l=3,xlab="E{Proporcédo de respostas
correctas}",ylab="Residuos")

> abline(h=0)

> qqnorm(residuos,pch=16,col=2,xlab= "Quantis da Distribuig&o Normal",

ylab="Quantis Amostrais",main="")

> gqline(residuos)

> par (op)

O comando par permite estabelecer o “esquema” da figura, neste caso, os graficos ficam “arranjados”
em 2 linhas por 1 coluna — mfrow=c(2,1) —, assim como definir a respectiva forma (quadrada,

13}
S

através de pty="s" - de “square”). Ao grafico dos residuos vs. valores esperados de Prop
(através de plot) acrescentdmos uma linha horizontal ao nivel de zero (através de abline) e, por
fim, desenhamos o normal probability plot dos residuos (com gqnorm e qqline).

E possivel testar se os residuos se distribuem normalmente através, por exemplo, de
> shapiro.test(residuos)
O resultado deste comando é

Shapiro-Wilk normality test
data: residuos
W = 0.936, p-value = 0.5719

O teste de sequéncias (ou “runs test” nos manuais anglofonos) permite testar, de forma simples
e robusta, se os pontos (dados) diferem sistematicamente da curva ajustada (modelo) comple-

mentando a informacdo do diagrama dos residuos wvs valores observados de X. |Conover| (1999)
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Figura 4: Analise grafica de residuos: residuos vs. valores esperados (esq.); e normal probability
plot dos residuos (dir.).

alerta para a reduzia poténcia estatistica do testes baseados em sequéncias. No R, sera necessa-
rio carregar alguns pacotes, tseries, quadprog e zoo (previamente instalados, através da barra
de ferramentas, a partir dos ficheiros *.zip disponiveis para o Windows®) em http://cran.at.r-
project.org/bin/windows/contrib/) fazendo e.g.

> library(tseries)
Depois basta fazer

> runs.test(factor(sign(residuos)))
para se obter o seguinte resultado

Runs Test
data: factor(sign(residuos))
Standard Normal = 0.5774, p-value = 0.5637

alternative hypothesis: two.sided

Pode comparar-se o ajuste de dois modelos distintos a um dado conjunto de dados confrontando
as SQE dos modelos ajustados através do teste de F. Sendo assim, depois de ajustar um modelo

logistico, § = C/[1 + Aexp(—Bz)] (Figura )E|, de formulagao mais generalizada do que o modelo

5Esta figura foi obtida através de

> plot(Prop~C02,las=1,x1im=c(0,1000), ylim=c(0,1),pch=16,cex=1.5, xlab="C02 (ppm)",ylab="Propor
¢80 de respostas correctas")

PropEsper<-predict(ajustes,newdata= 1ist(C02=seq(0,1000,length=100)),se.fit=T)
lines(PropEsper~seq(0,1000,length= 100),1lwd=2,c0l=6)

uppIC<-PropEsper+qt(.975,summary( ajustes)$df [2])*summary(ajustes)$sigm
lowIC<-PropEsper-qt(.975,summary( ajustes)$df[2])*summary(ajustes)$sigm
lines(uppIC~seq(0,1000,length=100), col=4)

lines(lowIC~seq(0,1000,length=100), col=4)

v

vV V. V V Vv
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Figura 5: Aspecto duma sessdo de trabalho no R.

“dose-resposta” anterior, através de

> ajustes<-nls(Prop~C/(1+A*exp(-B*C02 )),data=data.frame(C02=C02,Prop=Prop),
start=1ist(A=10,B=.0025,C=1))

> summary (ajustes)
os resultados do teste de F obtém-se facilmente através de
> anova(ajuste,ajustes)

Os passos descritos anteriormente, i.e. uma sessdo de trabalho (Figura [5), podem (e, na minha
opinido, devem) ser “guardados’. Para isso, criar um ficheiro de script (através de File>New
script), de facto um ficheiro texto, onde sdo “guardados” os comandos. Este ficheiro pode ser
carregado noutra sessdo de trabalho (através de File>Open script...) e as andlises e graficos
podem ser repetidos n-vezes (janela R Editor). O script do exemplo descrito aqui pode ser obtido
no sitio electrénico do autor.

Para terminar uma sessdo de trabalho, primeiro “limpar” da memoria os objectos criados (com

a fun¢do rm) e, depois, encerrar o programa (geralmente nao guardo uma “imagem” do ambiente
de trabalho):

> rm(list=1s()) ; qO

Consideracoes finais

As “dificuldades estatisticas” relacionadas com a utilizacdo do Excel®) da Microsoft (e da respec-
tiva ferramenta Solver®)) para analise de regressdo néo-linear (vd. [Esteves, [2010) limitam a sua
utilizacao aos casos “mais simples” ou para efeitos pedagogicos. Em situagoes “profissionais” deve
usar-se software dedicado, por exemplo SPSS®) ou R.



Embora as caracteristicas do R tornem (mais) dificil a aprendizagem, o seu caracter gratuito,
o facto de ser uma ferramenta bastante poderosa com boas capacidades ao nivel da programa-
¢do e um conjunto bastante vasto (e em constante crescimento) de packages que acrescentam
bastantes potencialidades estatisticas e graficas, o crescente interesse de utilizadores das mais
variadas formagoes (que se reinem anualmente desde 2004 nas conferéncias useR! — em 2011 a
useR!2011 decorrerda no Reino-Unido, ¢f. http://www.warwick.ac.uk/statsdept/useR-2011/)) e a
disponibilidade dos promotores (R Development Core Team) e da “comunidade” de utilizadores,
mais ou menos avangados, ajudam (e muito) esse processo. Os varios manuais (http://cran.r-
project.org/manuals.html), a pagina wiki (http://wiki.r-project.org/) e a mailing list de ajuda
(http://stat.ethz.ch/mailman/listinfo /r-help) permitem ultrapassar a (esmagadora) maioria das

dificuldades surgidas durante a utilizagao do R.
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